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ABSTRAKT

V diplomové praci se zaméefuji na navrh schematu laboratorniho ptipravku a

prostudovani zplsobii programovani obvodi CPLD firmy Altera. Ptipravek slouzi pro
vyvoj a demonstraci aplikaci v obvodech CPLD firmy Altera. Ptipravek je navrzen pro
programovani kabely Altera a Presto (vyrobce ASIX). Vstupni signdly jsou realizovany
soustavou piepinacu a tlaCitek na desce. Stavy vystupl jsou zobrazovany na LED
diodach, ptipadné na pfipojeném multiplexnim displeji. UZivatel méd moznost piipojit
externi zafizeni, pfes externi vstupy.
Prace je dale zaméfena na navrh desky ploSnych spoji laboratorniho piipravku,
nasledné vyrobé, oZiveni ptipravku a ovéfeni kompatibility programatorit ALTERA a
PRESTO. Zavér prace je zaméfen na praci s ndvrhovym prostiedim QUARTUS II.
Zejména se jednd o navod na praci se Sablonami a simulaci VHDL konstrukci.

KLICOVA SLOVA
Laboratorni ptipravek, CPLD, Altera, JTAG, VHDL, QUARTUS II.

ABSTRACT

In this thesis I aim at a design of the laboratory kit and study ways how to
programme CPLD devices made by Altera company. The product is used for
development and demonstration of applications in CPLD devices made by Altera
company. The kit is designed for Altera programming cables and Presto (made by
ASIX). Input signals are implemented by a set of switches and buttons on the board.
Output states are displayed by LED diods, possibly connected to multiplex the display.
The user can connect to external devices via external inputs.

Thesis is also aimed at the design PCB of the laboratory kit, subsequent production,
recovery and verification of compatibility ALTERA and PRESTO programmers. End of
the thesis aims on working with the Quartus II design environment. In particular, it is a
guide to working with templates and simulation of VHDL designs.

KEYWORDS
Laboratory kit, CPLD, Altera, JTAG, VHDL, QUARTUS II.
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UvVOD

Ukolem diplomové prace je prostudovat moznosti programovani obvodti CPLD
firmy Altera a navrhnout schema laboratorniho ptipravku s obvodem firmy Altera.
Obvody CPLD neboli Complex Programmable Logic Devices, jsou slozit¢ logické
obvody, které se vyuzivaji hlavné pro jejich rychlost a flexibilitu. MiZeme je nalézt
v raznych aplikacich, kde neni mozné vyuzit mikroprocesoru a kde se klade diraz na
rychlost jednoduchych operaci jako je multiplexovani, jednoduché aritmetické operace
a dalsi operace v kterych mikrokontrolery za témito obvody zaostavaji.

Laboratorni piipravek se tedy bude skladat z obvodu CPLD firmy Altera, ktery
bude programovan pies rozhrani JTAG. Hlavni zaméfeni bude na moznost
programovani pres externi programator Presto firmy Asix, ktery je momentalné velmi
roz$itenym prostfedkem. Ptipravek bude napajen zdrojem o napéti 5 V. Jako vstupni
periferie zde budou pouzity sestava prepinacu a také né€kolik tlacitek, které budou na
desce oSetfeny proti zakmitim pii stisku. Toto oSetfeni bude mozné 1 odpojit, kvili
moznosti vytvofeni programového oSetfeni téchto zakmiti. LED diody a 7segmentovy
multiplexni displej budou pouzity pro zobrazeni vystupii. Nebude zde chybét ani
moznost pfipojeni externich moduld pfes vyvedené konektory na desce.

Dalsim ukolem je navrhnout desku ploSnych spojii snaslednym osazenim
soucastkami a oZivenim. Cela prace bude vrcholit nékolika pfiklady VHDL konstrukci
pro ovéefeni funkEnosti desky a manudlem pro préaci s ptipravkem a s vytvofenou
Sablonou v navrhovém prostiedi QUARTUS II.



1 PROGRAMOVATELNE LOGICKE
OBVODY

V této kapitole jsou pouzity informace z pramenu [2]. Cislicové programovatelné
obvody se vSeobecné oznaCuji zkratkou PLD. Je to zkratka slovniho spojeni
Programmable Logic Devices. Jsou to obvody, které jsou sloZzeny z mnoha logickych
obvodii. Nejmens$im stavebnim prvkem je dvouvstupé hradlo NAND. Tyto obvody
samoziejm¢& neobsahuji jen je. Programovatelné jsou proto, Ze uzivatel je schopny si
tyto obvody nakonfigurovat podle svych potieb.

Programovatelné logické obvody se déli na tfi zakladni typy. Jsou to SPLD (Simple
Programmable Logic Devices), CPLD (Complex Programmable Logic Devices) a
obvody FPGA (Field Programmable Gate Arrays).

Velikost PLD obvodl se uvadi vétSinou ve dvou jednotkach. Je to pocet hradel,
avSak jde o zavadé¢jici pojem, protoze fada hradel je pouzita na pomocné a systémové
funkce. Z toho divodu je vhodnéjsi jednotkou velikosti PLD obvodl uzivany pocet
makrobunek. Makroburnika je vzdy jeden pamétovy ¢len (klopny obvod typu D), ktery je
doplnény o tfadu pomocnych hradel. Podoba makrobunky se u kazdého typu PLD
obvodi 1i8i. Typické struktura makrobuiiky z nejjednodussich obvodi PAL je zobrazena
na Obrazku 1.1.
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Obrazek 1.1 Struktura makrobunky obvodd SPLD typu PAL (ptevzato z [1])

Obvody CPLD maji makrobunky sloZitéjSi a obvody FPGA maji spiSe logické
bloky sdruzujici i fadu dalSich funkci.
Vyhody téchto obvodil jsou v tom, Ze jsou velmi rychlé. Jsou schopné pracovat na

frekvencich stovek MHz. Zvlasté kvili jejich rychlosti jsou vhodné na mistech, kde je
potieba rychla reakce, napiiklad sitové ptepinace (switch), zpracovani rychlych signald.



Dalsi vyhodou je tzv. pinovd rovnocennost. AZ na par specialnich pinl mizeme
kterykoliv pin ustanovit na nami zvolenou funkci. To usnadnuje navrh desky ploSného
spoje.

Nevyhodou je Castd nutnost napéjeni téchto obvodl vice standardy napéjeciho
napéti. Ale tato vlastnost neni pravidlem, jelikoZz uzZ mnoho obvodi mé v sobé
implementovana tzv. multivoltage cores, coZ vede k moZnosti napajeni jadra a periferii
stejnou velikosti napéti. Dals§i nevyhodou téchto obvodi je jejich Castd absence
analogovych obvodi (naptiklad DAC), ale to posledni dobou neni problém, jelikoz
dosti Casto se vyuziva kombinace PLD obvodl s mikroprocesory.

1.1  SPLD

V této kapitole jsou pouzity informace zpramenu [2]. Jsou to jednoduché
programovatelné obvody PAL, GAL, PLA a podobné. Jedna se o zastaralé obvody,
které vsobé seskupovaly jen malé mnozstvi makrobunck, coz umoziovalo
naprogramovat jen jednoduché logické funkce. Obvody maji pfedem definované
vstupni a vystupni piny a uzivatel jen konfiguruje vlastni logickou funkci pro kazdy
vystup zvlast, jelikoz na kazdém vystupu je umisténa jedna makrobunka. Zéakladni
princip obvodil fady PAL je na Obrazku 1.2.
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Obrazek 1.2 Zakladni princip obvodi PAL (pievzato z [2])

Jde o zobrazeni zakladniho principu obvodii PAL. Vlevo nahote jsou vstupy
obvodu. Jejich invertovand a neinvertovana hodnota je pfivedena na sou¢inovou matici
AND. Kazdy vodorovny spoj protinajici tuto matici reprezentuji vzdy jedno souc¢inoveé
hradlo. Tento spoj v sobé sdruzuje vice vstupl hradla ke kterému vedou a tim je mozné
na kazdé takové hradlo ptipojit vice vstupnich signali. Vystupy téchto hradel se spojuji
v souctovém hradle OR a ptes ptipadnou dalsi logiku prochéazeji az na vystupni pin.
Zaroven se tyto signdly Casto vraceji 1 zpét do matice, takze je mozné jejich stav vyuzit 1
u ostatnich ¢asti obvodu.

Na kazdém vystupnim pinu je navic umisténa jedna (jednobitova) makrobuiika.

Jejich nejvétsi zastupce je obvod PAL22V 10, ktery obsahuje 10 vystupt a tedy 10
makrobunék. CoZ mimo jiné znamena, ze z takového obvodu bylo moZné vytvoftit
maximalné desetibitovy binarni ¢itac, ktery jiz v§ak nemohl vykondvat nic dalsiho.



1.2 CPLD

V této kapitole jsou pouzity informace zpramenu [2]. Obvody SPLD jsou
v podstaté¢ zdkladem pro obvody CPLD (neboli slozit¢ programovatelné logickeé
obvody). Jejich typicka struktura je zobrazena na Obrazku 1.3.
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Obrazek 1.3 Struktura obvodi CPLD (pievzato z [2])

Jak lze vidét ze struktury obvodu CPLD, jde o matici mnoha obvodii SPLD, které
jsou spojeny globalni propojovaci matici. To umoznuje vytvofit mnohem slozitéjsi
konstrukci. Momentéalné 1ze od spole¢nosti Altera ziskat obvody o velikosti od 192 —
1700 makrobunék, coz znamena vetsi volnost, nezli u obvodid SPLD. VétSina obvodu
CPLD obsahuje i interni pamét’ EEPROM pro trvalé uloZeni konfigurace obvodu,coz je
vyhodou ve chvili, pferuSeni napajeni obvodu, jednak nemusi byt obvod nové
naprogramovan a nemusi se vyuZzivat externi paméti Flash pro obnovu konfigurace.

1.3 FPGA

V této kapitole jsou pouzity informace zpramenu [2]. Obvody FPGA jsou
nejslozitéjSimi, zaroven vSak také nejobecnéjSimi PLD obvody. Misto klasickych
makrobun¢k jsou sloZeny z tzv. logickych blokii a obsahuji az miliony ekvivalentnich
hradel (typické dvouvstupé hradlo NAND).

Na Obrazku 1.4 je typicka struktura FPGA.
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Obrazek 1.4 Struktura FPGA (pievzato z [2])

Tyto obvody ve velké mife obsahuji pro svou konfiguraci pouze integrovanou
pamét’ RAM. Z toho divodu je obvod nutné po kazdém zapnuti znovu nakonfigurovat.
To lze zaridit externi paméti eeprom, z které si dokazou obvody FPGA po zapnuti samy
nacist svou konfiguraci.



2 POUZITI OBVODU ALTERA MAX II

V této kapitole jsou pouzity informace zpramenu [3]. Pro ndvrh laboratorniho
ptipravku byl zvolen obvod CPLD fady MAX II od spole¢nosti ALTERA. Jedna se o
EPM240T100I5N. Je to nejmenSi velikost obvodu této fady a obsahuje 192
makrobun¢k, coz staci pro zdkladni aplikace v rozsahu zadanych funkci laboratorniho
ptipravku.

2.1  Vlastnosti rodiny MAX II

e nizka cena, nizka spotieba CPLD

obsahuje nevolatilni architekturu (neni nutno po kazdém spusténi

konfigurovat)

odbér v pohotovostnim rezimu mensi nez 25 uA

MozZnost vyuziti 4 globalnich hodinovych vstupt

UFM (User Flash Memory) blok o velikosti az 8 Kbits nevolatilni paméti

Jadro s podporou vice napétovych standardi 3.3 V/2.5 V nebo 1.8 V

Vstupné vystupni rozhrani podporujici napétoveé standarty 3.3 V,2.5V,

1.8V, 15V

e  Architektura obvodu umoziuje programovatelnou rychlost pfeb&hu, a
programovatelné pull-up a pull-down rezistory

e  MozZnost nastaveni na kazdy pin prichod Schmittovym obvodem pro
odruseni Sumu

e  Vstupy a vystupy obvodu jsou pIn¢ kompatibilni s PCI SIG (Peripheral
Component Interconnect Special Interest Group) PCI Local Bus
Specification, Revize 2.2 pro napét'ovy standart 3.3-V pracujici na frekvenci
66 MHz

e Podpora ptfipojovani za b&hu

e Zabudovany JTAG (Joint Test Action Group), BST(boundary-scan test)
systém vyhovujici standartu IEEE Std. 1149.1-1990

e  Systém ISP vyhovujici standartu IEEE Std. 1532

2.2 Vlastnosti zvoleného obvodu EPM240

Obsahuje 240 logickych hradel

Obsahuje 192makrobumék

Az 80 vstupné vystupnich uzivatelskych pini

Pouzité pouzdro 100-pinové TQFP

rozméry obvodu 16 mm x 16 mm, rozestup pint 0,5 mm

Napéjeni jadra napétim 3,3 V nebo 2,5V

Napéjeni vstupné-vystupnich bloka standardy 1,5V, 1,8 V, 2,5V ,33V



2.3  Konfigurace obvodi MAX II

V této kapitole jsou pouzity informace z pramenu [3]. Konfigurace obvodi fady
MAX II se provadi ptes rozhrani JTAG (IEEE Std. 1149.1). Toto rozhrani se sklada ze
ctyt signall. Jsou to TDI (Test Data Input) slouzici pro vstupni data, TMS (Test Mode
Select) slouzici pro volbu stavli programovani, TCK (Test Clock), ktery slouzi jako
hodinovy signal a TDO (Test Data Output) zafizuje odesilani dat zpét poptipadé do
dalSiho obvodu v fetézci. Pfes rozhrani JTAG je moZzné programovat vice obvodi
zaroven. Vyuziva se k tomu zapojeni obvodl za sebe do fetézce. Signadly TMS, TCK
jsou zapojeny do kazdého obvodu paraleln¢ a signadly TDI a TDO jsou zapojeny do
série.

V této praci se budu zaméfovat na mozZnost programovani za uziti externich
programatori. Pfipravek by mélo byt mozno naprogramovat pies programator od
spolecnosti Altera. Mezi né€ patii Altera ByteblasterMV, MasterBlaster, ByteBlaster 11 a
USB-Blaster cables. Tyto programatory by méli byt navrZzeny pro tyto obvody CPLD,
takZe neocekavam problémy jejich pouZiti a funkce. A jako druha moznost konfigurace
bude pres programator PRESTO od spolecnosti ASIX. Tento programator patii
momentalné k dosti pouzivanému zafizenim, a to hlavné z divodu Siroké moZnosti
programovani nejriznéjSich programovatelnych obvodil.

2.3.1 Programator PRESTO

V této kapitole jsou pouzity informace z pramenu [4]. Pro programovani soucastek
ptes rozhrani JTAG timto programatorem slouzi program snazvem JTAG SVF
PLAYER. Je s nim mozné programovat a testovat soucastky, pro které existuje software
poskytujici data ve formatu SVF nebo XSVF. To jsou napiiklad obvody CPLD
spole€nosti Altera, Xilinx, a dalsi. Format XSVF se vyhradné vyuZivd pro obvody
spolecnosti Xilinx. Nas bude zajimat format SVF.

U programatoru PRESTO na nas ¢eka jediné omezeni. Pro programovani pies tento
programator je potiteba vygenerovat SVF soubor a nasledné ho nahrat do obvodu ptes
dalsi software, ktery dodava ASIX. Ptesnéji pifes JTAG Player. DiivéjSi problémy
s programovanim pomoci PRESTA uz byly odstranény.
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selectable

=

DEVICE PRESTO

WITH vDD

GND
JTAG TDT

TCK
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TDO
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TMS

Obrazek 2.1 Zapojeni programatoru PRESTO (ptevzato z [4])

* Signdl selectable se mize chovat jako SCK nebo TRST popsany v SVF souboru
nebo muze byt definovany uzivatelem (log.1, log.0, tfeti stav, rizny béhem
programovani a po ném)
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Obrazek 3.1 Blokové schema ptipravku

3.1 Napajeni

Napdjeni celého ptipravku je navrzeno pro adaptér +5 V. Toto napéti je dale
stabilizovano dvéma stabilizatory LF33, které vstupni napéti 5 V stabilizuji na 3,3
V. Tento stabilizator dovoluje maximalni proudovy odbér 500 mA. Jeden stabilizator je
uzit pro napajeni 7segmentového displeje. Druhy stabilizator je uréeny pro napajeni
obvodu CPLD a vsech periferii. Zapojeni stabilizatoru je navrzeno podle doporuc¢eného
zapojeni udaného v dokumentaci stabilizatoru. Kazdy napajeci vstup CPLD je osazen
kondenzatorem o kapacité 100 nF, aby se ziskalo stabiln€j$i napéti, jelikoz tyto obvody
jsou na to citlivé. Zapojeni stabilizatorii je zobrazeno na obrazku 3.2.



Obrazek 3.2 Zapojeni stabilizatorQ

3.2  Programovani obvodu CPLD

Pro programovéani jsou z CPLD vyvedeny dva konektory, které slouzi
k pfipojeni externich programatori. Konektor snazvem PRESTO je pro pfipojeni
programatoru PRESTO spole¢nosti ASIX. Konektor nazvany ALTERA-PARALLEL je
pro piipojeni programatoru spole¢nosti Altera. Piny jsou rozmistény podle dokumentace
k programatorim. Zapojeni 1ze vidét na obrazku 3.3.

i
I

Obrazek 3.3 Zapojeni programovani
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3.3  Oscilatory

Pro vstup hodinového signalu je navrzen oscilator o frekvenci 50 MHz, ktery je
zamysSlen jako hlavni zdroj kmito¢tu. Zapojeni je ptevzato z doporuceného zapojeni od
vyrobce. Poté je zde navrzen oscilator o frekvenci 1 kHz, ktery je vytvoien z obvodu
74HC14D, coz je invertovany Schmittiiv obvod. Tento oscilator je zde pouzit pro fizeni
multiplexniho displeje. To lze vyfesit 1 pomoci oscildtoru 50 MHz ale zvolil jsem tuto
moznost kvili plnému vyuziti obvodu 74HC14D. A jako posledni moznost vstupu
hodinového signalu je zde pouZito tlacitko s oSetfenim proti zakmitlim, které mize
slouzit ke krokovani programu v obvodu CPLD.

R

c==

» 7222164

Obrazek 3.4 Katalogové zapojeni oscilatoru (pievzato z [5])

1 1
T 08RC
Rezistor R je zvolen na 130 Q, takZe dosazenim a upravou dopocitame
kondenzator C, abychom dosahli frekvence 1 kHz.
1 1
~08fR_08-1000-130

C = 9,6 uF

[

. 2
i

Obrazek 3.5 Zapojeni oscilatort

|
Y

|
i
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3.4  Vstupni prepinace

Pro demonstraci vstupnich signdlii jsem pouzil sestavu 12 piepinacl. Ty svym poctem
muzou reprezentovat binarni hodnotu az 4096. Zapojeni je zobrazeno na obrazku 3.5

Obrazek 3.6 Zapojeni pfepinaci

Zapojeni je navrzeno jako deli¢ napéti. Pfi rozepnutém stavu spinaci je na vstup
piivedeno napéti 3,3 V pres rezistor 10 kQ, coZ omezuje proud vstupujici do obvodu.
V piipad€é nastaveni nizké urovné vstupu bez omezeni proudu, by mohlo dojit
k ptetizeni obvodu CPLD. Tim padem je proud omezen na hodnotu

[— Vcc _ 3,3
" R37 10000

V tomto piipadé¢ jde o reprezentaci vysoké urovné. Nizkd uroven je definovana
sepnutym piepina¢em, kdy dojde k uzemnéni obvodu pies rezistor o hodnoté 470 Q.
Tim ziskame difive zminény deli€ napéti. V tomto ptipadé na vstup CPLD je piivadéna
nizka aroven o velikosti napéti
R29 470
=—Vec= 7
R29 + R37 470+ 10000

= 330uA

U, 3,3=0,148V
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3.5  Vstupni tlacitka

Dalsi vstup signalii je vytvoien Ctvetici tlacitek, u kterych je mozna volba oSetieni
mechanickych zakmita. V piipad€ nepouziti oSetfujici volby, 1ze zdkmity odstranit na
urovni softwaru. Volba zapojeni tlacitek je rozhodovana pomoci propojek.

Doba nestability tlacitek se vétSinou pohybuje vrozmezi 100 ns az 10 ms.
V nékterych ptipadech 1 vétsi. Pro oSetfeni zakmitl jsem zvolil hodnotu 1 ms. Pti volbé
rezistort na 10 kQ a 100 €, jsem dopocital hodnotu pouzitého kondenzatoru pomoci
vztahu

c 1 1
" (R21+4+R22)-f (10000 + 100) - 1000

Z toho davodu jsem zvolil hodnotu kondenzatoru na 100 nF. Zapojeni je
znazornéno na obrazku 3.7.

= 99 nF

#

=

}_1

£

.

P

:

}_7

Obrazek 3.7 Zapojeni tlacitek
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3.6  Vystupni LED diody

Jako demonstraci vystupnich dat jsem navrhl 12 LED diod. Pocet je totoZny s poctem
prepinacti. Diody jsou piipojeny na napajeci napéti 3,3 V pies rezistor 330 Q pro
omezeni proudu diodou na 10 mA. LED diody sviti ve chvili nastaveni na obvodu
CPLD nizké trovné na vstupu. Zapojeni je na obrazku 3.8.

11 1
N —
e
11 1
N L
o
1 1
N L
e
11 |
N I
e
11 1
N 1
Y
11 1
N —
Lo
1 e
N L
Civg
11 [ |
N I
e
11 —
N —
e
11  — |
N I
Lo
1 1
N L
e
11 (=
N L
e

Obrazek 3.8 Zapojeni LED diod

3.7  Multiplexné rizeny 7segmentovy displej

V navrhu jsem pouzil Sestimistny 7segmentovy multiplexné tizeny displej se spole¢nou
anodou. Pfedem jsem ovéfil kapacitni ndrocnost fadice displeje na obvod CPLD. A
fadiC zabiral ptiblizn€ 10 procent kapacity obvodu. Z toho diivodu jsem se rozhodl pro
pouziti multiplexné fizeného displeje. Pro omezeni proudu segmentem jsou pouzity
rezistory o velikosti 330 Q. Tim dosdhneme proudu 10 mA na segment. Je zde ptidana 1
moznost manudlniho odpojeni napajeni displeje pomoci propojky. Spinani napdjeni
bylo feSeno pres tranzistory BC 817 a BC 807 aby nedochdzelo k velkému zatizeni
CPLD. Napdjeni je ze samostatného stabilizdtoru. Schema zapojeni je na obrazku 3.9.
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Obrazek 3.9 Zapojeni displeje

3.8 Konektory pro externi I/O zarizeni

Jsou pouzity 3 konektory. Kazdy obsahuje 1 napéjeni 3,3 V a ptipojeni GND. Dvojice
konektort EXT1 a EXT2 maji vyvedeno 14 a 15 uZivatelskych pini obvodu CPLD. A
konektor EXT3 ma vyvedeno 5 uzivatelskych pinti. To znamena, ze celkem je mozné
vyuZzit az 34 uzivatelskych pinit obvodu CPLD pro pfipojeni externich zatizeni.

15



4 NAVRH DESKY PLOSNYCH SPOJU

Navrh desky ploSnych spoji probéhl podle doporuceni uvetejnénych na webu
UREL VUT Brno a podle doporuceni vedouciho prace.

AN

Obrazek 4.1 TOP vrstva navrzené desky

Obrazek 4.2 BOTTOM vrstva navrzené desky

16
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5 NAVOD NA PRACI S PRIPRAVKEM

Pro praci sptipravkem jsem vytvofil dv€é Sablony. Jedna Sablona je se
schematickou vrcholovou jednotkou. Druhé pak s textovou. Obé Sablony jsou uloZeny
na doprovodném CD. Budeme se zabyvat praci se Sablonou se schematickou
vrcholovou jednotkou.

a sablona_sch,bdf* [x]
D& twlecfAEAA0ADL-OTITANNSOON VEFIMGL - - - S _|
ks kiocti ich
R S - S l alks0 mhertz {— Lf clks0 Qs 0} U e g
el T b s, A eme i o
: ‘ L inet —5i5.01 : ; i : F
g g k-
g g L — €6 0
[ e
ﬂz‘ inst& ot T e QU 12 G ) A
ﬂa‘ PIN_96
[AN3 Jge szgla
AN 14 tH. o it R - M
B e 1, A‘—I
Higakmit T ;u’_:EL:i' )
LN Rt s
Fiidzakmit e S
AR T
$tidzakmit e ST
A ] & i
Obrazek 5.1 Schematicka vrcholova jednotka Sablony
) W
5.1  Postupy pro praci se Sablonou v QUARTUS II

Po spusténi softwaru QUARTUS 1II se nam zobrazi nabidka na vytvofeni nového
projektu nebo otevieni stavajiciho projektu. Zvolime otevieni stdvajiciho projektu. A
vybereme nasi Sablonu s nazvem ‘“‘sablona_sch.qpf*.

5.1.1 Prejmenovani projektu

V tuto chvili mdme otevienou Sablonu. Ale abychom neméli vSechny projekty se
stejnym jménem, provedeme nasledujicich par krokt pro pfejmenovani.

Z diavodu, ze Quartus nedisponuje piimo funkci Save Project As, rozklikneme si
nabidku Project a zvolime polozku Copy Project. Otevie se ndm nabidka pro zvoleni
nového umisténi projektu a nazev projektu. V naSem ptipad¢ zvolime jméno “vzor sch*
a potvrdime. V ptipad¢ zvoleni mista projektu, které neexistuje, budeme dotazani, jestli
se ma slozka vytvofit. Zvolime Ano. Timto krokem se nam vytvofil na novém umisténi
projekt s novym jménem. Ale pofad se ndm zobrazuje vrcholova jednotka s nazvem
starym. Proto v okn& Project Navigator piepneme na zalozku Files a dvojklikem
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otevieme Sablona sch.bdf. Nasledné¢ provedeme ulozeni pod jinym nazvem. V naSem
piipad€ pod jménem vzor sch.bdf. Automaticky se nam tento noveé vytvoreny soubor
piidal do projektu. Jelikoz nam nyni zastal v projektu 1 pivodni soubor, tak na ngj
klikneme pravym tlacitkem mysi a zvolime odstranéni z projektu. Nyni klikneme na
nami vytvofeny soubor vzor sch.bdf pravym tlacitkem a zvolime ho za vrcholovou
jednotku. Nyni mame projekt vytvofen. Pod hlavni nabidkou se nam zobrazuje
posledni vzpominka na Sablonu. To znaci jaké nastaveni projektu je aktualni. V naSem
pfipadé kam jsou pfifazené piny na pouzdie obvodu, atd. Jestli ndm tato vzpominka
vadi, mizeme ji zménit. V menu rozklikneme Project a zvolime polozku Revision.
Otevie se nam okno, v ném poklepame na polozku New Revision. Vysko¢i nam okno ve
kterém nastavime nové jméno, vnasem piipadé vzor sch a vpolozce Based On
Revision ponechame sablona sch. Tim zajistime totoZzné nastaveni se Sablonou.
Zkontrolujeme, jestli mdme zaSkrtnuté moznosti pro Copy Database a Set As Current
Revision. Poté potvrdime OK. Vidime, Ze se nam ptidal novy profil a Ze ten stary nam
tam zustal. Ted’ je jen na nas jestli ten stary smazeme nebo ne. Timto ndm uz nestoji nic
v cesté pokracovat v navrhu.

5.1.2 Seznameni s vrcholovou jednotkou

Nyni si pfedstavime schematickou vrcholovou jednotku. Na obrazku 5.1 vidime
vytvorené dva bloky. Zdrojové kody jsou uvedeny v ptiloze B.7 a B.2.

Prvni blok nazvany délicka kmitoctu slouzi jako d€li¢ kmito¢tu. Na vstupu mame
oscilator o frekvenci 50 MHz. Na vystupu pak 1 MHz, 1 kHz a 1 Hz.

Druhy blok je nazvan jako disp a funguje jako ftadi¢ multiplexné ftizeného
7segmentového displeje. Vstupni signaly jsou pojmenovany pismeny 4, B, C, D, E, F,
dp, clk50 a khertz. Vstupy A az F jsou Sestibitové a kazdy vstup slouzi pravé jednomu
digitu na displeji. Kazdy bit reprezentuje pravé jen jeden segment z celé Cislice. Vstup
dp je taktéz Sestibitovy a kazdy bit reprezentuje pravé jednu tecku ke kazdému digitu.
Pomoci vstupu clk50 je frekvenci 50 MHz obnovovany vstupni tdaje ze vstupu 4 — F' a
dp. Vstupem khertz je s frekvenci 1 kHz postupné piepinané zobrazované digity na
displeji. Na Sablon¢ je kromé vySe popsanych blokd i mnoho vstupti a vystupl. Ty
slouzi minimdln¢ k ilustraci vSech moZznych periferii, které¢ se daji vyuzit pro ndvrh.
V jiném ptipad¢€ je mozné vstupy a vystupy piimo vyuzit a propojit je s navrhem.

5.1.3 Vytvoreni vlastniho konstrukcéniho bloku

Pro na$ navrh budeme potiebovat vytvofit dalsi blok, ktery bude plnit funkci,
kterou mu nadefinujeme. Pro vytvofeni, v nabidce File klikneme na moznost New.
V okné, které se nam zobrazi, vybereme VHDL File a potvrdime OK. Otevie se nam
soubor, ktery si nasledné uloZime pod nadmi Z4danym nazvem. Automaticky se ndm
piida do projektu. Nyni néds ¢eka sestrojeni konstrukce. Zapis je ¢lenén nasledujicim
zpusobem.
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LIBRARY ieee;
USE ieee.std logic 1164.ALL;
USE ieee.std logic_unsigned.ALL;

Entity Counter IS

PORT (
hertz, Smer, Areset: IN std logic;
Sreset, Nacteni, Cen: IN std logic;
Din: IN std logic_vector (3 downto 0);
Count: OUT std logic_vector (3 downto 0)

);
END Counter;

ARCHITECTURE CountArch OF Counter IS
SIGNAL CntInt: std logic vector (3 downto 0):= "1010";

BEGIN
PROCESS (hertz, Areset) BEGIN
IF Areset = '1l' THEN
CntInt <= "0000";
ELSIF (hertz'event AND hertz = '1l') THEN
IF Sreset = '1l' THEN
CntInt <= "0000";
ELSIF Nacteni = '1l' THEN
CntInt <= not Din;
ELSIF CEn = '1l' THEN
IF Smer = 'l' THEN
CntInt <= CntInt + 1;
ELSE
CntInt <= CntInt - 1;
END IF;
END IF;
END IF;
END PROCESS;
Count <= not CntlInt;
END CountArch;

Kdyz mame vytvofenou konstrukei, tak soubor uloZime a provedeme Analyzu a
syntézu, kterou spustime dvojklikem v okné Tasks na Analysis & Synthesis. Pokud je
vSe v porddku mizeme pokracovat ve tvofeni schematického bloku. V okné projektu
pravym tla¢itkem klikneme na nami vytvofeny soubor a vybereme moznost Create
symbol Files For Current File. Jelikoz cela Sablona potifebuje obnovit schematické
symboly vSech blokii, provedeme tento krok i1 pro ostatni bloky. V dalSim kroku
ptejdeme do vrcholové jednotky. Klikneme do schematu pravym tlac¢itkem a zvolime
Update Symbol Or Block. Dvojklikem na levé tlacitko nyni otevieme okno s nazvem
Symbol. V okné rozklikneme polozku Project, kde vybereme symbol, ktery jsme pied
chvili vytvofili. Zkontrolujeme, jestli nemdme zaskrtnuté policko Insert Symbol As
Block a pokud neni zaSkrtnuté tak potvrdime OK. Symbol ndsledné vlozime do
schematu. Vratim se jesté¢ k oknu Symbol. V ptipade, ze potiebujeme do projektu vlozit
néjaky dalsi symbol, ktery patii k béZnym funkcim jako na ptiklad AND, OR a mnoho
dalSich mtizeme si vybrat zknihovny Quartus. V tomto piipadé nebudeme hledat
v polozce Project ale v polozce Libraries. Po nalezeni toho co potiebujeme, se
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postupuje dale stejné jako pii vloZzeni ndmi vytvofeného bloku. Kdyz se vratim zpatky
do vrcholové jednotky, kde uz mame vlozen nas blok, je potfeba ho ptipojit. Pfipojuje
se kliknutim a drzenim levého tlacitka mySi na vyvod bloku a tazenim k vyvodu,
kterému ho chceme piipojit. Tady musime davat pozor. V ptipadé€, ze chceme ptipojit
sbérnici napiiklad k symbolu napéjeni, musime ptipojovat ve sméru od sbérnice
k napajeni. V ptipadé¢ opacném se tyto dva objekty taktéz spoji, ale ne pomoci
sbérnicového spoje ale jen jediného spoje, ktery ndm nasledné pti syntéze bude hlasit
chybu z divodu, Ze nejsou vSechny vstupy piipojeny. V tomto ohledu podle mého
nazoru je navrhovy systém trochu neSikovny. V ptipad€ nutnosti ptipojeni vice zdroja
do sbérnice, vyvedeme kousek sbérnice, tu nasledné pojmenujeme jmény signall
oddélené carkami, které chceme piipojit. V piipadé nevyuziti n€kterych LED diod na
desce je potieba je vnavrhu piipojit na napajeni, protoze LED diody, kdyz na né
piivedeme logickou nulu tak sviti. Pfipojenim na logickou jednicku dosahneme
nesviticich LED diod, které nejsou pouZity.

— Dir

— Areset

— Sreset
-ESW[H--U] D—%%LCL | Nacteni
: L switd.enn | CEN
o [_——Vce D . Din[3..0]

Obrazek 5.2 Ptipojeni vice zdroji do sbérnice

Nyni miizeme provést syntézu, ktera nam odhali, jestli se nam nckde nachazi
syntaktickd chyba.
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5.1.4 Prirazeni vyvodi

Ptifazeni pind lze v programu Quartus II provést tfemi zplisoby. Prvni zptsob je
pies Pin Planner, v kterém je graficky zobrazené pouzdro obvodu. Pro nazornost je to
dobry zptsob, ale v piipadé zadavani vice pinti je to zpiisob trochu zdlouhavy.

g Pin Planner - C:f/Users/r n‘*’?
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H J
) 3 Node Name Direction Location 10 Bank. 1/0 Standard Reserved Current Strength =
9 Areset Input PIN_6 1 3.3V LV default) 16mA (default) ‘g:
it B e Input PIN_3 1 3.3V LV...default) 16mA (default) 4
% | [ dkso Input PIN_12 1 3.3V LV...default) 16mA (default)
» o Count{3] Cutput PIN_85 2 3.3V LV...default) 16mA (default)
= ||| Count2] Cutput PIN_56 2 3.3V LV_default) 16mA (default)
o count{1] Qutput PIN_87 2 3.3V LV._default) 16mA (default)
£ Count{0] Cutput PIN_88 2 3.3V LV default) 16mA (default)
D digit[s] Output PIN_36 1 3.3V LV...default) 16mA (default)
o digit(4] Cutput PIN_35 1 3.3V LV...default) 16mA (default)
o digit[3] Cutput PIN_34 1 3.3V LV...default) 16mA (default)
|| digit[Z] Cutput PIN_33 1 3.3V LV default) 16mA (default)
& digit[1] Cutput PIN_30 1 3.3V LV.__default) 16mA (default)
=D digitlo] Output PIN_29 1 3.3V LV...default) 16mA (default) o

0%  00:00:00

Obrazek 5.3 Pritazeni vyvodi pies Pin Planner

Dal$im zplsobem je pomoci Assignment Editoru, ktery je v podstaté obdobny
zpusob piitazovani pint jako od Xillinx ve form& UCF souboru. A poslednim zplisobem
je pomoci TCL scriptu, ktery lze vygenerovat pres Quartus a nasledné jej jen lehce
upravit podle naSich potieb. Pro moji osobu pfiSel jako nejptivétivéjsi zplsob
piifazovani praveé Assignment Editor.

V nasi Sablon¢ jsou uz vSechny piny pfifazeny a tak uz nam zbyva jen upravovat
pomoci Assignment Editoru nazvy pinti pro konstrukci. Zptisoby pfitazovani pint jsou
intuitivné feseny, takze neni potieba nikterak do hloubky popisovat zptlisob.

22



Fle Edt View Tools Window Hep &
<<news: v Filter on node names: = ~ Category: Al hd
& tatu From To Assignment Mame Value Enabled Entity Comment Tag -
1 I = oo Location PIN_12 Yes 3
2+~ I & dit(s] Location PIN_36 Yes [
3 v I @ it Location PIN_35 Yes I 3
2 I & i) Location PIN_34 Yes 1
s+ I & i) Location PIN_33 Yes 1
&+ I & cigit1] Location PIN_30 Yes |
7« I & cigito] Location PIN_29 Yes | —
5+ I & diod[11] Location PIN_S8 Yes [
3+ I & diod[10] Location PIN_97 Yes 7
10 v [ & diod] Location PIN_96 Yes T
1 v [ & dods] Location PIN_95 Yes I
12 v [ & dod7] Location PIN_92 Yes 1
13+ N & diods] Location PIN_91 Yes 1
14+ [ & dids] Location PIN_90 Yes |
15+ [ & did[4] Location PIN_89 Yes | —
16 v _ ¥ seg[7] Location PIM_44 fes _
17 + I & seqlt] Location PIN_43 Yes 7
18 v _ & segld] Location PIN_42 Yes _
19+ [ & s Location PIN_41 Yes I
0 v _ ¥ seg[3] Location PIMN_40 Yes _
21 + N & =[] Location PIN_39 Yes 1
2 v _ o seq[1] Location PIN_38 Yes _
1z v I S -0 Location PIN_37 ves [— -
0%  00:00:00

Obrazek 5.4 Ptifazeni vyvodu v Assignment Editoru

5.1.5 Programovani pripravku

Ve chvili jak mame spravné ptidéleny piny, tak ndim nezbyva nic jiného nez cely
projekt zkompilovat dvojklikem na Compile design v okné Tasks. V ptipadé¢ kdyz
dojde k uspésnému zkompilovani nasi konstrukce, tak se automaticky vygeneruje
soubor pro zapis do obvodu, ktery ma koncovku pof (programmming output file). Pro
nahrani konstrukce do obvodu slouzi program s nazvem Programmer, Ktery spustime
dvojklikem na polozku Program Device v okné Tasks. Tim, ze ho spoustime piimo
pres Quartusu se nam automaticky nacte i soubor s programem. V piipadé Ze mame
programator, ktery je podporovan softwarem Programmer, tak postupujeme
nasledujicim zplisobem. Nyni nas c¢ekd detekce a nastaveni naSeho programatoru,
kterym chceme naprogramovat obvod. Klikneme na tlacitko Hardware Setup a
vybereme programator, ktery mame ptipojeny k pocitaci a potvrdime OK. Nyni sta¢i uz
jen kliknout na tladitko Start v nabidce na levé strané okna. Provede se nahrani
konstrukce do obvodu. A jestli je v§e v poradku, tak se nam zobrazi okno s potvrzenim
uspésného nahrani programu.
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éaHardwareSamp.” No Hardware Mode: Progress: :}

[~] Enable real-time I5P to allow background programming (for MAX I and MAX ¥ devices)
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Obrazek 5.5 Generovani SVF souboru

V piipadé programovani piipravku programdtorem Presto od firmy ASIX,
nebudeme klikat na tlacitko Hardware Setup, ale v menu File klikneme na moznost
Create JAM, JBV, SVF or ISC File. Zobrazi se nam okno, kde nastavime format
souboru na Seridl Vector Format (.svf) a vkolonce TCK frequency nastavime jen 3
MHz zpavodnich 18 MHz. To ztoho diivodu, Ze programator Presto podporuje
maximalné 3 MHz hodiny. V ptipad€ pokud zanechame 18 MHz, taktéz se ndm podati
obvod naprogramovat, ale bude pribéh programovani zdlouhavéjsi. Kdyz méme vse
nastaveno, tak stiskneme OK. Tim se ndm vygeneruje SVF soubor s instrukcemi.
K dokonc¢eni programovani potfebujeme si nainstalovat software od vyrobce ASIX
snazvem JTAG Player. JTAG Player je uzivatelsky velmi jednoduchy program.
V prvni fadé rozklikneme polozku Options a vybereme polozku Select Presto.
ZaSkrtneme programem identifikované zatizeni a potvrdime. Poté uZ jen v nabidce File
klikneme na Open and Process a vybereme soubor .svf, ktery jsme si nechali
vygenerovat a potvrdime. Okamzité se zaCne programovat obvod.

i — = =
# ITAG SVF Player for PRESTO 2.3 fE [oE] = |

File Options Help

LS = = = — 4

Obrazek 5.6 JTAG SVF Player
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5.2  Postupy pro simulace a analyzy VHDL konstrukci

5.2.1 Funk¢ni simulace

V prvé fadé¢ budeme muset povolit generovani souboru pro funk¢ni simulaci. To
provedeme v nabidce Assignments -> Settings. Vybereme kategorii Simulation, Jako
prostfedek nastavime ModelSim-Altera. Rozklikneme moZnost More EDA Netlist
Writer Settings. Tady nastavime Generate third-party EDA tool command script for
RTL function simulation a také moznost pro gate-level simulation, tim ziskame
vygenerovany soubor 1 pro post-fit simulaci. VSe potvrdime. Vygenerujeme si Sablonu
na Test Bench. Dale budu pouzivat vyraz benc, ktery je uz vcelku zdomacnély pojem.
V menu Processing -> Start -> Start Test Bench Template Writer, tim se nam
vygeneruje ben¢. Nyni si spustime Modelsim Altera. Piejdeme do nabidky File ->
Change Directory, kde si nastavime cestu k naSemu projektu. Poté v menu File -> New
-> Library v okné, které se ndm zobrazi vybereme posledni moznost A new library and
a logical mapping to it a zaddme nazev knihovny, ve které budeme mit soubory pro
simulaci. Po potvrzeni pokracujeme na menu Compile -> Compile. Zde si vybereme
nami stvofenou knihovnu a oznacime soubory *vho a *vht. Potvrdime a pravym
tlacitkem klikneme na nds§ ben¢ v knihovné a vybereme Edit. Nyni nds ¢eka uprava
vygenerovan¢ho bence a napsani vstupnich stimulii pro simulaci. Pro ptiklad dokladam
zdrojovy text k benci.

LIBRARY ieee;
USE ieee.std logic 1164.all;

ENTITY operator vhd tst IS
END operator vhd tst;

ARCHITECTURE operator arch OF operator vhd tst IS

SIGNAL A STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL A out STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL B : STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL B out STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL C out STD_LOGIC_VECTOR(3 DOWNTO O0) ;

SIGNAL tll : STD LOGIC:='Q";

SIGNAL tl12 : STD LOGIC:='0"';

SIGNAL t13 STD LOGIC:='0"';

SIGNAL tl4 STD LOGIC:='Q";

SIGNAL tl15 STD LOGIC:='Q";

SIGNAL kH : STD LOGIC:='0"';

COMPONENT operator

PORT (

A in std logic vector (3 downto 0);
B : in std logic vector (3 downto 0);
tll, tl2, t13, tl4, tl15: in std logic;

C out: out std logic vector (3 downto 0);
A out: out std logic vector (3 downto 0);
B out: out std logic vector (3 downto 0);
kH: in std logic
)i
END COMPONENT;
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BEGIN

il : operator

PORT MAP (
A => A,
A out => A out,
B => B,

B out => B out,
C out => C out,
tll => tl1,

tl2 => tl2,

tl3 => tl3,

tld => tl4,

tl5 => tl5,

kH => kH

)

Clock GEN : PROCESS BEGIN
loop
kH <= '0'; wait for 500 us;
kH <= '1'; wait for 500 us;
end loop;
END PROCESS Clock GEN;

always : PRCESS BEGIN

A <= "1100"

B <= "0011" ;
Wait for 10ms;
tll <= '1'; wait for 1lms; tll <= '0'; wait for 1ms;
tl2 <= '1'; wait for 1lms; tl2 <= '0'; wait for 1ms;
tl3 <= '1'; wait for lms; tl3 <= '0'; wait for 1ms;
tld <= '1'; wait for 1lms; tl4 <= '0'; wait for 1ms;
tl5 <= '1'; wait for 1lms; tlb5 <= '0'; wait for 1ms;
END PROCESS always;
END operator arch;

Ve chvili jak mame ben¢ piipraveny, tak ho ulozime a zkompilujeme ho. Poté uz
stac¢i jen dvakrat kliknout na test bech v knihovné a spusti se. Nyni si jen tahnutim mysi
pfiddme kontrolované signaly z okna Objects do okna Wave. Pokud neni zobrazeno
okno waves automaticky, tak si ho spustime v menu View -> Wave. Ted uz nezbyva
nic jiné¢ho nez nastaveni délky simulace a spusténi.
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| Wave - Defauit — —
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/bit_operat_vhd_tst/B

/bit_operat_vhd_tst/A_out
# _ |bit_operat_vhd_tst/B_out

Jbit_operat_vhd_tst/ti1

Jbit_operat_vhd_tst/i2
Jbit_operat_vhd_tst/ti3
Jbit_operat_vhd_tst/ti4
/bit_operat_vhd_tst/ti5
Jbit_operat_vhd_tst/C_out 0000

Obrazek 5.7 Prubéhy simulace v ModelSim

Nyni v okné Waves si mizeme zkontrolovat, jestli ndm naSe konstrukce opravdu déla to
co ma. V piipad¢, Ze ned¢la tak timto zptisobem Ize rychleji dohledat zdroj problému,
ktery by se ve VHDL kodu samostatné obtizné¢ hledal, zejména u slozit¢jSich
konstrukeci.

5.2.2 POST-FIT Simulace

Simulace Post Fit neboli simulace po rozmisténi je v podstaté simulace bence do
kterého jsou zapoclitany 1 Casové prodlevy signalovych drah. Proto taky postup je
obdobny s bencem s tim rozdilem, Ze u Post Fit simulace je pouzit jesté vygenerovany
soubor *.sdo, ktery nese informace o Casovych zpozdénich. Postup je nasledujici.
Jelikoz jsme si uz u bence povolili generovani i souboru *.sdo, tak mizeme pracovat
pfimo v programu ModelSim. Po vytvotfeni naSi knihovny a zkompilovani souboru
*vho a *vht jako u bence. Klikneme v menu na Simulate -> Start Simulation. Otevie
se nam okno, kde si vybereme naSi knihovnu a oznac¢ime soubor s bencem. Prejdeme na
zalozku SDF, kde pomoci tlalitka Add vybereme vygenerovany soubor s casovym
zpozdénim a potvrdime. Poté zaSkrtneme moznosti Disable SDF warnings a reduce
SDF' errors to warnings. Tim potlaCime chyby, které nam vyskoci v ptipad€, ze
nemame pripojené n¢jaké piny v navrhu. Potvrdime OK. Nyni se ndm spustila post fit
simulace a nasledujici prace je totozna s ben¢em. V mém piipad¢€ pti provedeni post fit
simulace pro konstrukci s bitovymi operacemi se ¢asové zpozdéni nikterak neprojevilo.

5.2.3 Staticka ¢asova analyza

Pro vytvofeni statick¢ Casové analyzy je potieba provést Place&Route. Poté
v okné Tasks rozklikneme polozku TimeQuest Timing Analysis a dvakrat poklepeme na
polozku TimeQuest Timing Analyzer. Tim se ndm spusti TimeQuest. Budeme dotazani,
jestli chceme vygenerovat SDC soubor ze souboru QOSF. To potvrdime. Nyni
v programu TimeQuest v okné Tasks spustime Report Datasheet. Tim se nam spusti
analyza a nasledné¢ zobrazi vypis ¢asovych zpozdéni nasi konstrukce.
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File View Nefist Constraints Reports Script Tools Window Hep &
Report © 5| ([E— ﬂ.
5 TineQuest Tining Anclyaer Sunmmary Data Port CockPort  Rise  Fal  ClockEdge  ClockReference
# (2 Datasheet Report 1 CEn hertz 5187 5187 Rise hertz
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B3 Minimum Clock to Output Times 3 Din[2] hertz 3.986 3.986 Rise hertz
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v B Open Project... B
3 Netlist Setup
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Obrazek 5.8 TimeQuest - Zobrazeni vysledkd po spusténi Report Data

V ptipadé, ze nas zajimaji jen urcité cesty, tak spustime v okné Tasks polozku
Report Path, ktera se nachazi v Custom Reports. Zobrazi se ndm okno, kde si piimo
nastavime cestu. Poté jen potvrdime tlacitkem Report Path. Tim se nam provede
analyza zadanych cest.

Paths

Report number of paths: 1

Maximum number of paths per endpoint:

Output
Report panel name:  Report Path
[ File name: | :
File options
@ Overwrite Append l itpen _!
[] consale

Tdl command:  report_path -npaths 1 -panel_name {Report Path}

= (Fepmnran) (com ] (o]

Obrazek 5.9 TimeQuest - nastaveni cest pro analyzu
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Parametry statické cCasové analyzy lze =ziskat 1 pfimo v navrhovém
systému Quartus. Staci V okné Tasks -> TimeQuest Timing Analysis poklepat na
polozku View Report. Spusti se nam zalozka Compilation Report, kde v polozce
TimeQuest Timing Analyzer se ndm zobrazi ziskané ¢asové parametry.

ok o Cone v B e e e e e
ER Flow Summary Slack From Node To Node Launch Clock Latch Clock Relationship Clock Skew Data Delay
B Flow Settings 1 3081 Cntlnt[3] Cntint(3]  hertz hertz 0.000 0.000 3.302
E= Flow Non-Default Glob Settings 2 3285  Cntint[2) Cntint(2]  hertz hertz 0.000 0.000 3.506

3 422  Cntint[1] Cntint[1]  hertz hertz 0.000 0.000 4,497
=2 Fin Flypred Time 4 4357  Cotint[]] cntint[2]  hertz hertz 0.000 0.000 4,578
&5 Flow 05 Summary 5 4647 Cntlnt[Z] Crtnt(3]  hertz hertz 0.000 0.000 4863
B Flow Log 6 4670  Cntint[) Cntint[0]  hertz hertz 0.000 0.000 4,891
> (1 Analysis & Synthesis 7 4967  Cntint[1] Cntint[3]  hertz hertz 0.000 0.000 5.188
b (3 Fitter 8 4991  Cntint[) Cntint[1]  hertz hertz 0.000 0.000 5.212
= 9 509  Cntnt0)] Cntint[2]  hertz hertz 0.000 0.000 5.317
10 5706  Cnilnt[] Cntint[3]  hertz hertz 0.000 0.000 5.927
E Summary
B Paralel Compilation
EA Clocks

% Fmax Summary
% Setup Summary
ER Hold Summary
B Recovery Summary
Removal Summary
% Minimum Pulse Width Summary
4 {3 Worst-Case Timing Paths
% Setup: hertz’
ﬁ Hold: *hertz'
E# Minimum Pulse Width: 'hertz'
+ [ Datasheet Report
1 Clock Transfers
Report TCCS
Report RSKM
EH Unconstrained Paths
j) Messages
> D TimeQuest Timing Analyzer GUL

Obrazek 5.10 Quartus II - zobrazeni vysledkt analyzy

6 VZOROVE VHDL KONSTRUKCE

Pro demonstraci funkce ptipravku jsem vytvofil nasledujici ¢tyfi VHDL konstrukce.
Jejich zdrojové kody jsou uvetejnény v piiloze. Zde uvadim jen jejich popis funkce.
Vsechny konstrukce jsou pIlné¢ funkéni a odzkouSené a jsou ptilozeny na doprovodném
CD.

6.1 Hodiny

Tato VHDL konstrukce funguje jako klasické hodiny. Udaj ¢asu je zobrazovan na
7segmentovém displeji ve tvaru HH.MM.SS. Sekundy jsou také zobrazovany pomoci
skupiny LED diod, které blikaji v taktu 1 sekundy. Nastavovani hodin je provedeno
pomoci skupiny pifepinact. Prvni Sestice pfepinacl slouzi k nastaveni hodin a druha
Sestice k nastaveni minut. Nastaveni se uloZi po stisku tlacitka tl1.

Zdrojovy kéd je v ptiloze B.3
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6.2  Bitové operace

Bitové operace je program, ktery slouzi k demonstraci logickych funkci AND, OR,
EX OR, NOR a negace. Jako vstupy jsem pouzil dva Ctyrbitové signdly, které jsou
reprezentovany skupinou piepinacii. Stav vstupii je zobrazovan pomoci LED diod pfimo
nad prepinaci. Vystup bitové operace je zobrazovan pomoci zbylé Ctvetice LED diod.
Vybér provadéné funkce je volen pomoci pétice tlacitek. Prvni tlaCitko tll reprezentuje
funkci AND, tlacitko tI2 funkci OR, tlacitko tI3 funkci EX OR, tlacitko tl4 funkci NOR
a tlacitko tl5 reprezentuje funkci negace vstupu A.

Zdrojovy kod je v ptiloze B.4

6.3 Prevod BIN to HEX

Tato konstrukce ptfevadi bindrni kod na hexadecimalni. Jako binarni vstup jsou
pouzity prepinace. Ty jsou rozdéleny na tfi Ctvefice bitd. Kazda ctvetice bitl je
pievadéna na hexadecimalni hodnotu, kterd je néasledné zobrazena na 7segmentovém
displeji. Na displeji prvni tii digity pofad zobrazuji nuly a na zbylych tfech digitech jsou
zobrazeny pievody z pfepinaci. V tomto programu je jest¢ vloZena dalsi funkce, ktera
zobrazuje na LED diodach preddefinované posloupnosti podle toho, které tlacitko je
zrovna stlaceno.

Zdrojovy kéd je v ptiloze B.5

6.4 Cita¢

Jedna se o ctyibitovy ¢ita¢ s volbou sméru ¢itani, ktery je dany prvnim v fadé
prepina¢i. Citaé ma funkci synchronniho i asynchronniho resetu, Asynchronni reset je
na tlacitku tll, synchronni na tlacitku tl2. Na tlacitku t13 je moZnost nacteni pocatecni
hodnoty ¢itani z posledni Ctvetice pfepinacli na desce. Pro povoleni ¢itani je pouzito
tladitko tl4. Stav &itade je zobrazen na Gtvefici LED diod. Citani je provadéno signalem
o frekvenci 1 Hz.

Zdrojovy kdd je v priloze B.6
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7 ZAVER

V diplomové praci jsem mél za ukol navrhnout a zrealizovat vyvojovou desku pro
praci s obvody CPLD od spole¢nosti ALTERA. Tento bod jsem splnil. Piipravek jsem
ozivil a provedl ovéfeni funkcnosti vSech periferii. Piipravek je pln€ funkéni. Zkousky,
které jsem pfi praci na projektu provedl, potvrdily, Ze programator USB Blaster funguje
spravné. Podatilo se rovnéz vyieSit problém s programatorem Presto, které uvadi
vyrobce programatoru. Zejména omezeni frekvence programovani a uUprava SVF
souboru. Zpracoval jsem nékolik VHDL konstrukci pro ovéfeni funkce ptipravku. Tyto
konstrukce byly vytvofeny na zéklad¢ Sablon, které jsem vytvoiil. Oba typy Sablon 1
vSechny ptiklady jsou uvedeny na doprovodném CD. DalSim ukolem bylo vytvofit
manudl pro praci s pfipravkem a postupy praci v navrhovém systému QUARTUS II
vcetn¢ doprovodnych aplikaci pro simulace a analyzu, jelikoz Altera na svém webu
nema piili§ mnoho informaci o praci s navrhovym systémem QUARTUS II. V tomto
ptipadé ma spole¢nost Xilinx mnohem lépe fesenou uzivatelskou podporu. Tento navod
by mél poslouzit pro praktickou praci s pfipravkem pro nové uzivatele se systémem
QUARTUS IL
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SEZNAM SYMBOLU, VELICIN A ZKRATEK

PLD
SPLD
CPLD
FPGA
JTAG
TDO
TDI
TMS
TCK
VHDL
EEPROM
PLA
PAL
GAL
LED
SVF
NAND
EX OR
DAC
RAM
UFM
ISP
QPF
BDF
UCF
SDO
VHO
VHT
SDC
QSF

Programmable Logic Device

Simple Programmable Logic Device
Complex Programmable Logic Device
Field Programmable Gate Array
Join Test Action Group

Test Data Output

Test Data Input

Test Mode Select

Test Clock

Hardware Description Language
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B ZDROJOVE KODY

B.1  Déli¢ kmito¢tu — zdrojovy kod

LIBRARY ieee;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;
USE ieee.std logic 1164.all;

ENTITY delicka kmitoctu IS

PORT

(

clk50: IN STD LOGIC;
mhertz: OUT STD LOGIC;
khertz: OUT STD LOGIC;
hertz: OUT STD LOGIC

);
END delicka kmitoctu;

ARCHITECTURE delicka kmitoctu architecture OF delicka kmitoctu IS

SIGNAL mhertz_count: STD_LOGIC_VECTOR(5 DOWNTO 0O) := (OTHERS => '0"');
SIGNAL khertz_count: STD_LOGIC_VECTOR(9 DOWNTO 0) = (OTHERS => '0");
SIGNAL hertz_count: STD_LOGIC_VECTOR(9 DOWNTO 0) = (OTHERS => '0");
SIGNAL mhertz en: STD_LOGIC := '0';
SIGNAL khertz en: STD_LOGIC := '0';
SIGNAL hertz en: STD_LOGIC := '0';
BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1l' THEN
mhertz count <= mhertz count + 1;
IF mhertz count = "110001" THEN -— 49
mhertz en <= '1';
mhertz count <= (OTHERS => '0'");
ELSE
mhertz en <= '0';
END IF;

END IF;
END PROCESS;

mhertz<=mhertz en;
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-- generace 1 kHz z mhertz en
PROCESS (clk50) BEGIN

IF clk50'event AND clk50 = '1l' THEN
IF mhertz en = 'l' THEN
khertz count <= khertz count + 1;
IF khertz count = "1111100111" THEN -- 999

khertz en <= '1"';
khertz count <= (OTHERS => '0'");

ELSE
khertz en <= '0';
END IF;
ELSE
khertz en <= '0';
END IF;
END IF;

END PROCESS;
khertz<=khertz en;

-- generace 1 Hz z 1 kHz
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1' THEN
IF khertz en = 'l' THEN
hertz count <= hertz count + 1;
IF hertz count = "1111100111" THEN -- 999
hertz en <= '1";
hertz count <= (OTHERS => '0'");

ELSE
hertz en <= '0';
END IF;
ELSE
hertz en <= '0';
END IF;
END IF;

END PROCESS;
hertz<=hertz en;

END delicka kmitoctu architecture;
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B.2 Radi¢ displeje — zdrojovy kod

library IEEE;

use IEEE.STD LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY disp IS

PORT (c1k50: IN STD LOGIC;
khertz: IN STD LOGIC;
digit: OUT STD LOGIC VECTOR (5 DOWNTO O0) ;
seqg: OUT STD LOGIC VECTOR (7 DOWNTO O0);
A IN STD_LOGIC VECTOR (5 downto 0);
B: IN STD_LOGIC VECTOR (5 downto 0);
C: IN STD_LOGIC VECTOR (5 downto 0);
D: IN STD_LOGIC VECTOR (5 downto 0);
E: IN STD_LOGIC VECTOR (5 downto 0);
F: IN STD_LOGIC VECTOR (5 downto 0);
dp: IN STD LOGIC VECTOR (5 downto 0)
)
END disp;
ARCHITECTURE Behavioral OF disp IS
SIGNAL cd: STD _LOGIC VECTOR (2 DOWNTO 0) := "000";
SIGNAL curr: STD _LOGIC VECTOR(5 DOWNTO 0) := "000000";
SIGNAL dot: STD_LOGIC := '0';
BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1' THEN
--inkrementace "ukazatele" - vyber vzdy jen jedne ze sesti segmentovek
IF khertz = '1l' THEN
cd <= cd + 1;
IF cd = "101" THEN
cd <= "000";
END IF;
END IF;

-- podle "ukazatele" cd je aktivovana prislusna pozice (aktivni v 0)

CASE cd IS -- curr je zobrazena cifra, digit je pozice na displeji
WHEN "000" => curr <= F; digit <= "111110"; dot <= dp(0);
WHEN "001" => curr <= E; digit <= "111101"; dot <= dp(1);
WHEN "010" => curr <= D; digit <= "111011"; dot <= dp(2);
WHEN "O11" => curr <= C; digit <= "110111"; dot <= dp(3);
WHEN "100" => curr <= B; digit <= "101111"; dot <= dp(4);
WHEN OTHERS => curr <= A; digit <= "011111"; dot <= dp(5);
END CASE ;

-- nastaveni prislusneho znaku na segmentovce podle BCD kodu na vstupu
CASE curr IS

WHEN "000000" => seg <= dot & "0111111"; -- 0
WHEN "000001" => seg <= dot & "0000110"; -- 1
WHEN "000010" => seg <= dot & "1011011"; -- 2
WHEN "000011" => seg <= dot & "1001111"; -- 3
WHEN "000100" => seg <= dot & "1100110"; -- 4
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WHEN "000101" => seg <= dot
WHEN "000110" => seg <= dot
WHEN "000111" => seg <= dot
WHEN "001000" => seg <= dot
WHEN "001001" => seg <= dot
WHEN "001010" => seg <= dot
WHEN "001011" => seg <= dot
WHEN "001100" => seg <= dot
WHEN "001101" => seg <= dot
WHEN "001110" => seg <= dot
WHEN OTHERS => seg <= dot &
END CASE;

END IF;

END PROCESS;

END Behavioral;

Y 2 R & R R 2 2 2 R

"1110001";
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B.3 Hodiny — zdrojovy kod

library IEEE;

use IEEE.STD LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY cas IS

PORT (c1lk50: IN STD_LOGIC;
hertz: IN STD_LOGIC;
SW: IN STD_LOGIC_VECTOR (0 to 11);
tll: IN STD_LOGIC;
A: OUT STD LOGIC VECTOR (5 downto O0);
B: OUT STD LOGIC VECTOR (5 downto 0);
C OUT STD LOGIC VECTOR (5 downto 0);
D: OUT STD LOGIC VECTOR (5 downto 0);
E: OUT STD LOGIC VECTOR (5 downto 0);
F: ouT STD_LOGIC_VECTOR (5 downto 0)
);
END cas;
ARCHITECTURE Behavioral OF cas IS
SIGNAL diods: STD_LOGIC VECTOR (11 downto Q) :="000000000000";
SIGNAL hodiny: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL minuty: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL sekundy: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL hod: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL min: STD_LOGIC VECTOR (5 downto 0):="000000";
SIGNAL sec: STD_LOGIC VECTOR (5 downto 0):="000000";
SIGNAL Al: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL Bl: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL Cl: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL D1: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL El: STD LOGIC VECTOR (5 downto 0):="000000";
SIGNAL F1l: STD LOGIC VECTOR (5 downto 0):="000000";
BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1' THEN

IF t11="1"' then
hodiny <= NOT sw(0 to 5);
hod <= NOT sw(0 to 5);
Cl <= "000000";
minuty <= NOT sw(6 to 11);
E1l <= "000000";
min <= NOT sw(6 to 11);
sekundy <= (OTHERS => '0');
END IF;

IF hertz='1l' THEN
sekundy <= sekundy + 1;
sec <= sekundy;
Al <= "000000";
min <= minuty;
hod <= hodiny;
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Cl <= "000000";
E1l <= "000000";
IF sekundy = "111011" THEN
sekundy <= "000000";
minuty <= minuty + 1;
IF minuty = "111011" THEN
minuty <= "000000";
hodiny <= hodiny + 1;
IF hodiny = "010111" THEN
hodiny <= "000000";
END IF;
END IF;
END IF;
END IF;
IF sec < "001010" then
Bl <= sec;
ELSIF sec >= "(001010" then
Al <= Al + "000001";
sec <= sec - "001010";
END IF;
IF min < "001010" then
D1 <= min;
ELSIF min >= "001010" then
Cl <= C1 + "000001";
min <= min - "001010";
END IF;
IF hod < "001010" then
Fl <= hod;
ELSIF hod >= "001010" then
El <= E1 + "000001";
hod <= hod - "001010";
END IF;
END IF;
END PROCESS;
A<=Al; B<=Bl; C<=Cl; D<=Dl; E<=El; F<=F1;

END Behavioral;
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B.4 Bitové operace — zdrojovy kod

library IEEE;

use IEEE.STD LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.ALL;
use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY operator IS

PORT (
A : in std logic_vector (3 downto 0);
B : in std logic_vector (3 downto 0);
tll: in std logic;
tl2: in std logic;
t13: in std logic;
tl4: in std logic;
tl5: in std logic;
C_out: out std logic vector (3 downto 0);
A out: out std logic vector (3 downto 0);
B out: out std logic vector (3 downto 0);
khertz: in std logic

)
END operator;

ARCHITECTURE Behavioral OF operator IS

SIGNAL C: std logic vector (3 downto 0):="0000";

SIGNAL A in: std logic vector (3 downto 0):="0000";

SIGNAL B _in: std logic vector (3 downto 0):="0000";
BEGIN

PROCESS (khertz, tl11, tl12, tl3, tl4, tl5) begin

IF khertz'event AND khertz = '1l' THEN
A in <= not A;
B in <= not B;

IF tll='1l"' then
C <= A in and B_in;
ELSIF tl12='1l"' then
C <= A in or B in;
ELSIF t13='1l"' then
C <= A in xor B _in;
ELSIF tl4='1l' then
C <= A in nor B in;
ELSIF t15='1" then
C <= not A in;
END IF;
END IF;
END PROCESS;

C_out <= not C;
A out <= not A in;

B out <= not B in;

END Behavioral
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B.5

library IEEE;

Prevod BIN to HEX — zdrojovy kod

use IEEE.STD LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.

ALL;

use IEEE.STD LOGIC UNSIGNED.ALL;

ENTITY disp IS
PORT (c1k50,
SW:
digit:
seqg:
diod:
tl1,
);
END disp;

kH, khertz:

tl2, tl13, tl4

IN STD LOGIC;
IN STD LOGIC VECTOR (11 DOWNTO 0) ;
OUT STD LOGIC VECTOR (5 DOWNTO 0) ;
OUT STD LOGIC VECTOR (7 DOWNTO 0) ;
OUT STD LOGIC VECTOR (11 DOWNTO 0);
, tl5: IN STD LOGIC

ARCHITECTURE Behavioral OF disp IS

SIGNAL cd: STD LOGIC VECTOR(2 DOWNTO 0) := "000";
SIGNAL curr: STD LOGIC VECTOR(3 DOWNTO 0) := "0000";
SIGNAL dp: STD_LOGIC := '0';
SIGNAL bcdint: STD LOGIC VECTOR (23 downto O0);
SIGNAL swl: STD _LOGIC VECTOR (11l downto 0):=
SIGNAL tlacitko: STD_LOGIC VECTOR (4 downto 0):= "00000";
BEGIN
PROCESS (clk50) BEGIN
IF clk50'event AND clk50 = '1' THEN
bcdint <= sw & swl;
IF khertz en = '1l' THEN
cd <= cd + 1;
IF cd = "101"™ THEN
cd <= "000";
END IF;
END IF;
-- podle "ukazatele" cd je aktivovana prislusna pozice (aktivni

"ll1l111111111"™;

v 0)

CASE cd IS -- curr je zobrazena cifra, digit je pozice na displeji
WHEN "000" => curr <= bcdint (3 DOWNTO 0); digit <="111110"; dp <='0"';
WHEN "001" => curr <= bcdint (7 DOWNTO 4); digit <="111101"; dp <='0"';
WHEN "010" => curr <= bcdint (11 DOWNTO 8); digit <="111011"; dp <='0";
WHEN "011" => curr <= bcdint (15 DOWNTO 12); digit<="110111"; dp <='0";
WHEN "100" => curr <= bcdint (19 DOWNTO 16); digit<="101111"; dp <='0"';
WHEN OTHERS => curr <= bcdint (23 DOWNTO 20);digit<="011111"; dp <='0";
END CASE ;

-- nastaveni prislusneho znaku na segmentovce podle BCD kodu na vstupu
CASE curr IS

WHEN "1111" => seg <= dp & "0111111"; -- 0

WHEN "1110" => seg <= dp & "0000110"; -— 1

WHEN "1101" => seg <= dp & "1011011"; -— 2

WHEN "1100" => seg <= dp & "1001111"; -- 3

WHEN "1011" => seg <= dp & "1100110"; -— 4

WHEN "1010" => seg <= dp & "1101101"; -- 5

WHEN "1001" => seg <= dp & "1111101"; -- 6

WHEN "1000" => seg <= dp & "0000111"; -— 7

WHEN "0111" => seg <= dp & "1111111"; -- 8
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WHEN "0110" =>
WHEN "0101" =>
WHEN "0100" =>
WHEN "0011" =>
WHEN "0010" =>

WHEN "0001" =>
WHEN OTHERS =>
END CASE;

END IF;

END PROCESS;

END Behavioral;

seg
seg
seg
seg
seg
seg
seg

dp
dp
dp
dp
dp

2 22 2 22 &2 & R

"1101111"™;
"1110111";
"1111100";
"0111001";
"1011110";
"1111001";
"1110001";
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B.6 Cita¢ — zdrojovy kéd

LIBRARY ieee;
USE ieee.std logic 1164.ALL;
USE ieee.std logic_unsigned.ALL;

Entity Counter IS
PORT (hertz, Smer, Areset, Sreset, Nacteni, CEn:IN std logic;
Din: IN std logic_vector (3 downto 0);
Count: OUT std logic_vector (3 downto 0)
) ;
END Counter;
ARCHITECTURE CountArch OF Counter IS
SIGNAL CntInt: std logic vector (3 downto 0):= "1010";
BEGIN

PROCESS (hertz, Areset) BEGIN

IF Areset = '1l' THEN
CntInt <= "0000";
ELSIF (hertz'event AND hertz = '1l') THEN
IF Sreset = '1l' THEN
CntInt <= "0000";
ELSIF Nacteni = '1l' THEN
CntInt <= not Din;
ELSIF CEn = '1l' THEN
IF Smer = '1l' THEN
CntInt <= CntInt + 1;
ELSE
CntInt <= CntInt - 1;
END IF;
END IF;
END IF;

END PROCESS;

Count <= not CntInt;

END CountArch;
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